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About This Document

This document explains how to install the BEA WebLogic Integration – Business 
Connect.

This document is organized as follows:

Chapter 1, “System Requirements,” provides the basic information you need to 
know before installing WebLogic Integration – Business Connect.

Chapter 2, “Installation and Configuration,” provides important information 
about the WebLogic Integration – Business Connect license file, an overview of 
maintainence considerations, and a quick reference outline of the steps for  
installing and configuring WebLogic Integration – Business Connect.

Chapter 3, “Installation on Windows,” describes how to install the WebLogic 
Integration – Business Connect software on Windows systems.

Chapter 4, “Installation on UNIX,” describes how to install the WebLogic 
Integration – Business Connect software on UNIX systems.

Chapter 5, “Upgrading,” describes how to upgrade from the a WebLogic 
Integration – Business Connect 2.1 installation.
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What You Need to Know

This document is intended for use by people who oversee installation, configuration, 
maintenance and use of WebLogic Integration – Business Connect. This book was 
written under the assumption that WebLogic Integration – Business Connect 
administrators have a working knowledge of:

Your organization’s business hardware, software and practices

Electronic data interchange (EDI) and electronic commerce

A graphical user interface

The Internet, including use of a browser

In addition, your network, systems or mail administrator might find parts of this 
document useful as a guide for installation and configuration.

This document can also serve as a reference for EDI department supervisors and 
technical personnel.

e-docs Web Site

BEA product documentation is available on the BEA corporate Web site. From the 
BEA Home page, click on Product Documentation or go directly to the “e-docs” 
Product Documentation page at http://e-docs.bea.com.

How to Print the Document

You can print a copy of this document from a Web browser, one file at a time, by using 
the File→Print option on your Web browser.
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A PDF version of this document is available from the BEA WebLogic Integration – 
Business Connect documentation Home page, which is available on the documentation 
CD and on the e-docs Web site at http://e-docs.bea.com. You can open the PDF 
in Adobe Acrobat Reader and print the entire document, or a portion of it, in book 
format. To access the PDFs, open the BEA WebLogic Integration – Business Connect 
documentation Home page, click the PDF Files button, and select the document you 
want to print.

If you do not have the Adobe Acrobat Reader installed, you can download it for free 
from the Adobe Web site at http://www.adobe.com/.

Contact Us!

Your feedback on the BEA WebLogic Integration – Business Connect documentation 
is important to us. Send us e-mail at docsupport@bea.com if you have questions or 
comments. Your comments will be reviewed directly by the BEA professionals who 
create and update the WebLogic Integration – Business Connect documentation.

In your e-mail message, please indicate that you are using the documentation for the 
BEA WebLogic Integration – Business Connect 7.0 release.

If you have any questions about this version of BEA WebLogic Integration – Business 
Connect, or if you have problems installing and running BEA WebLogic Integration – 
Business Connect, contact BEA Customer Support through BEA WebSupport at 
www.bea.com. You can also contact Customer Support by using the contact 
information provided on the Customer Support Card, which is included in the product 
package.

When contacting Customer Support, be prepared to provide the following information:

Your name, e-mail address, phone number, and fax number

Your company name and company address

Your machine type and authorization codes

The name and version of the product you are using

A description of the problem and the content of pertinent error messages
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Documentation Conventions

The following documentation conventions are used throughout this document.

Convention Item

boldface text Indicates terms defined in the glossary.

Ctrl+Tab Indicates that you must press two or more keys simultaneously.

italics Indicates emphasis or book titles.

monospace 
text

Indicates code samples, commands and their options, data structures and 
their members, data types, directories, and file names and their extensions. 
Monospace text also indicates text that you must enter from the keyboard.
Examples:
#include <iostream.h> void main ( ) the pointer psz

chmod u+w *

\tux\data\ap

.doc

tux.doc

BITMAP

float

monospace 
boldface 
text

Identifies significant words in code.
Example:
void commit ( )

monospace 
italic 
text

Identifies variables in code.
Example:
String expr

UPPERCASE 
TEXT

Indicates device names, environment variables, and logical operators.
Examples:
LPT1
SIGNON
OR
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{ } Indicates a set of choices in a syntax line. The braces themselves should 
never be typed.

[ ] Indicates optional items in a syntax line. The brackets themselves should 
never be typed.
Example:
buildobjclient [-v] [-o name ] [-f file-list]... 
[-l file-list]...

| Separates mutually exclusive choices in a syntax line. The symbol itself 
should never be typed.

... Indicates one of the following in a command line: 
That an argument can be repeated several times in a command line
That the statement omits additional optional arguments
That you can enter additional parameters, values, or other information

The ellipsis itself should never be typed.
Example:
buildobjclient [-v] [-o name ] [-f file-list]... 
[-l file-list]...

.

.

.

Indicates the omission of items from a code example or from a syntax line. 
The vertical ellipsis itself should never be typed.

Convention Item
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CHAPTER
1 System Requirements

The following topics are provided regarding the hardware, software, communications, 
and interfaces required for installing WebLogic Integration – Business Connect.

Concepts

“Windows Requirements” on page 1-1

“UNIX Requirements” on page 1-3

Note: We strongly recommend that you read the release notes in the readme file on 
the installation CD for supplemental information about system requirements 
and installation.

Windows Requirements

The following topics provide the hardware and software requirements for running 
WebLogic Integration – Business Connect on computers with Microsoft Windows 
operating systems.

“Hardware on Windows” on page 1-2

“Software on Windows” on page 1-2
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1 System Requirements
Hardware on Windows

A Windows computer must have the following minimum configuration.

A Pentium-class processor running at 400 MHz or faster

Random Access Memory (RAM) 

256MB recommended

128MB minimum

250MB available hard drive space

Note: We recommend at least a 1 GB hard drive for both the application and the 
documents you exchange.

SVGA monitor

CD-ROM drive (for installation)

TCP/IP network interface

Local area network (LAN) card and persistent Internet connection is required.

Internet Explorer 4.0.1 or later.

Note: Internet Explorer is required because the installation process uses IE 
scripts to create shortcuts. After installation you can use Internet Explorer 
4.0.1 or later or Netscape Navigator 4.0 or later as the browser.

Software on Windows

WebLogic Integration – Business Connect supports the following Windows operating 
systems: Windows NT 4.0 and Windows 2000.

To use Windows NT 4.0, you also must have installed the domestic United States 
version of Service Pack 4 or later with the associated bug fixes.

Note: Apache as the mediated web server is not supported when configured on 
Windows NT or Windows 2000.
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UNIX Requirements
Administrator Rights for Windows NT and 2000

For Windows NT or 2000, you must have administrator rights to successfully install 
the application. If you are not sure whether you have administrator rights for a 
machine, check with your system administrator.

Recommended Software for Windows

Although Internet Explorer 4.0.1 or later must be installed to successfully install 
WebLogic Integration – Business Connect, after installation you can use Internet 
Explorer 4.0.1 or later or Netscape Navigator 4.0 or later. You use a browser to read 
WebLogic Integration – Business Connect online help files and to obtain third-party 
certificates from certificate authorities such as VeriSign, Inc.

In addition, you need Adobe Acrobat Reader to view and print Using WebLogic 
Integration – Business Connect, which is provided in a portable document format 
(PDF) file named buscon.pdf. The PDF guide can also be found in the userdoc 
directory on the installation CD and in the doc subdirectory after you install the 
application. Acrobat Reader is available free from Adobe Systems Inc., 
www.adobe.com.

UNIX Requirements

The following topics provide the hardware and software requirements for running 
WebLogic Integration – Business Connect on UNIX computers.

“Hardware on UNIX” on page 1-4

“Software on UNIX” on page 1-4
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1 System Requirements
Hardware on UNIX

Your computer must have the following minimum configuration to successfully install 
WebLogic Integration – Business Connect on a UNIX platform.

Random Access Memory (RAM)

256MB recommended

128MB minimum

250MB available hard drive  space (see note)

CD-ROM drive

TCP/IP network interface

A persistent Internet connection.

Note: We recommend at least a 1 GB hard drive for both the application and the 
documents you exchange.

Software on UNIX

This topic lists the operating systems and other software necessary to install and 
configure WebLogic Integration – Business Connect on UNIX platforms.

X Windows and Operating Systems

Your system requires X Windows and any of the following UNIX operating systems:

Hewlett-Packard HP-UX 11.0

IBM AIX 4.3.3

Sun Solaris 2.6, 2.7 or 2.8
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UNIX Requirements
OS Patches

Patches for some operating systems are required to support the Java technology that 
WebLogic Integration – Business Connect uses. For a list of recommended patches, 
see the release notes in the readme file on the installation CD.

Recommended Software for UNIX

You should have Internet Explorer version 4.0.1 or later or Netscape Navigator version 
4.0 or later. You use a browser to read WebLogic Integration – Business Connect 
online help files and to obtain third-party certificates from certificate authorities such 
as VeriSign, Inc.

In addition, you need Adobe Acrobat Reader to view and print Using WebLogic 
Integration – Business Connect, which is provided in a portable document format 
(PDF) file named buscon.pdf. The PDF guide can also be found in the userdoc 
directory on the installation CD and in the doc subdirectory after you install the 
application. Acrobat Reader is available free from Adobe Systems Inc., 
www.adobe.com.
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CHAPTER
2 Installation and 
Configuration

The following topics are provided for installing and configuring WebLogic Integration 
– Business Connect.

Concepts

“About the User License File” on page 2-2

“Maintenance Considerations” on page 2-5

Procedures

“Installation and Configuration Quick Reference Outline” on page 2-3

Note: We strongly recommend that you read the release notes in the readme file on 
the installation CD for supplemental information about system requirements 
and installation.
Installing WebLogic Integration – Business Connect 2-1



2 Installation and Configuration
About the User License File

A file named license.xml contains the permissions for using specific functionality 
of WebLogic Integration - Business Connect. If you purchased WebLogic Integration 
– Business Connect, you received a production version of license.xml from BEA. 
Copy this file to a location that will be accessible during installation. You will be 
prompted to provide the path to the license file during the installation process. If you 
are evaluating WebLogic Integration – Business Connect leave the location of the 
license file blank when prompted; the installer will automatically generate a 
license.xml which allows you evaluate all functionality of WebLogic Integration - 
Business Connect for 30 days.

The license.xml file is installed in your WebLogic Integration – Business Connect 
installation directory. Each time you start a system component, such as Server, 
Administrator or Tracker, the system checks for the presence of this file in the 
installation directory. The license.xml file makes available the functionality you are 
authorized to use under your user license. You cannot use the application unless the 
file is present.

Do not delete the license.xml file from the installation directory. Also, do not 
attempt to alter the file in any way as this could make your system inoperable.

If you have purchased WebLogic Integration – Business Connect, we recommend that 
you keep a copy of the license.xml file in a secure place other than the installation 
directory in the event you need to re-install the application on the same or a different 
computer.
2-2 Installing WebLogic Integration – Business Connect



Installation and Configuration Quick Reference Outline
Installation and Configuration Quick 
Reference Outline

The following is a quick reference outline of the steps for installing and configuring 
WebLogic Integration – Business Connect.

For a typical installation, it is strongly recommended you perform each of the 
following steps in order.

1. Make sure your organization has the required hardware and software to support 
WebLogic Integration – Business Connect.

See: 
Chapter 1, “System Requirements”

2. Make sure your system’s date and time settings are accurate. This can prevent 
problems in trading documents later.

3. Install WebLogic Integration – Business Connect.

See:
Chapter 3, “Installation on Windows”
Chapter 4, “Installation on UNIX”

4. Complete the configuration steps listed in Table 2-1 to set up WebLogic 
Integration – Business Connect to exchange documents with your trading 
partners.

After you have successfully installed WebLogic Integration – Business Connect, 
Using WebLogic Integration – Business Connect provides the information you 
need to configure the application.

To view a PDF version of Using WebLogic Integration – Business Connect, do 
one of the following:

On Windows, choose Start→Programs→BEA WebLogic Integration – 
Business Connect 7.0→Administrator Guide. 

On UNIX, open installation_directory/doc/admin.pdf in Adobe 
Acrobat.
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2 Installation and Configuration
Using WebLogic Integration – Business Connect is also available on the BEA 
corporate Web site at the following URL:

http://e-docs.bea.com/wlibc/docs70/admin/index.html

Table 2-1 lists steps required to configure WebLogic Integration – Business 
Connect. All references are to Using WebLogic Integration – Business Connect.

Table 2-1  Configuration Steps

Step Description

1 Start the Administrator application.
See “Starting Administrator or Tracker” in “Getting Started”

2 Set up your company profile.
See “Company Profiles”

3 Generate or obtain a certificate for your company profile.
See “Keys and Certificates”

4 Export your company profile to your trading partners.
See “Exporting a Company Profile to a File” in “Company Profiles”

5 Import or create profiles for your trading partners.
See “Partner Profiles”

6 Start the Server application to begin sending and receiving documents.
See “Starting the Server Application”  in “Getting Started”

7 Start the Tracker application to view records of trading activity.
See “Tracker”
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Maintenance Considerations
Maintenance Considerations

The following actions should be taken to maintain the WebLogic Integration – 
Business Connect system and its data:

Back up all system directories and files as part of your normal backup schedule.

Review the system logs at frequent intervals to detect potential problems.

Check the specified e-mail accounts for alerts and notifications.

Make sure there is enough disk space available for the system and the 
documents you exchange.

Use the web browser server monitor to determine the status of the Server 
application. Select Tools→Launch Server Monitor in Administrator or Tracker.

Use your available system tools to check memory usage.

Check the archive logs.
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2 Installation and Configuration
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CHAPTER
3 Installation on 
Windows

The following topics are provided for installing WebLogic Integration – Business 
Connect on computers with Microsoft Windows operating systems.

Procedures

“Installing on Windows” on page 3-1

“Configuring as a Windows Service” on page 3-3

“Uninstalling on Windows” on page 3-8

Installing on Windows

Use this procedure to install WebLogic Integration – Business Connect from the 
installation CD.

Before installing WebLogic Integration – Business Connect, see Chapter 1, “System 
Requirements,” to ensure your hardware, software and communications are ready. In 
addition, see Chapter 2, “Installation and Configuration,” before installing.

Optionally, we recommend that you create a Windows user ID and password to be used 
by all persons who work with WebLogic Integration – Business Connect. Use this user 
ID for all installation, configuration, maintenance or monitoring of the Administrator, 
Server and Tracker applications. See your systems administrator for information and 
assistance.
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3 Installation on Windows
Steps

1. Close any applications that might be running on your local machine.

2. Place the installation CD in the CD-ROM drive. When the CD menu appears, 
click Windows to launch the installation wizard.
If the CD menu does not appear after you insert the CD in the CD-ROM drive, 
use Windows Explorer and double-click the install.bat file in the windows 
directory on the CD.

3. Follow the on-screen prompts for installing the application.

If you have purchased a license from BEA, provide the complete path to the 
license.xml file you received when prompted. If you are evaluating the 
software, leave the path blank and click Next to continue. A a 30-day evaluation 
license will be created for you. See “About the User License File” on page 2-2.
When prompted to select an installation directory, be advised that you cannot use 
a directory name that includes blank spaces.
When you are prompted to click Install, a window appears that shows the 
progress of the installation. When the installation is completed, an installation 
summary window appears. 

4. Click Exit to exit the window.
The installation process adds the WebLogic Integration – Business Connect 
program group to the Start menu. The icons are shown in the following table.

There also are icons for opening the PDF file for Using WebLogic Integration – 
Business Connect and the help systems for Administrator and Tracker.

Table 3-1  Program Icons

Administrator Start Server Tracker

View Server Log Stop Server Document Generator
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Configuring as a Windows Service
5. Select Start→Programs→BEA WebLogic Integration – Business Connect 
2.1→Administrator to log on to Administrator. See “Getting Started” in Using 
WebLogic Integration – Business Connect.

Configuring as a Windows Service

Running WebLogic Integration – Business Connect as a service in Windows NT or 
Windows 2000 provides the following functionality:

Windows can start the Server application during the Windows system 
initialization process and stop the application when Windows is shut down.

The Windows system administrator can use Windows services to manually start 
or stop the service from the local machine that hosts WebLogic Integration – 
Business Connect.

Note: While the Server application is set up as an Windows service, you should not 
start the application from the Start menu.

The following topics are provided for using WebLogic Integration – Business Connect 
as a Windows service.

“Installing the ECEngine Utility to Support Configuration as a Windows 
Service” on page 3-4

“Configuring as a Windows NT Service” on page 3-4

“Configuring as a Windows 2000 Service” on page 3-5

“Starting as a Service” on page 3-6

“Removing from the List of Services” on page 3-6

“Changing the NT Service Start-Up Options” on page 3-7
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3 Installation on Windows
Installing the ECEngine Utility to Support Configuration 
as a Windows Service

Use this procedure to install the ECEngine utility to enable you to configure WebLogic 
Integration – Business Connect as a service in Windows NT or Windows 2000.

Steps

1. Click Start in Windows and then open an MS-DOS command prompt window.

2. Use the cd command to change the current directory to the following:
installation_directory\util\NT Service

3. Then type the following:
ECEngine.exe -i

4. Press Enter. Wait for the prompt to reappear.

5. Close the MS-DOS command prompt window.

6. Go to “Configuring as a Windows NT Service” or “Configuring as a Windows 
2000 Service” on page 3-5.

Configuring as a Windows NT Service

Use this procedure to configure WebLogic Integration – Business Connect as a service 
in Windows NT.

1. Install the ECEngine utility. See “Installing the ECEngine Utility to Support 
Configuration as a Windows Service” on page 3-4.

2. In the Windows NT Control Panel, double-click the Services icon. The Services 
dialog box opens.

3. In the Services dialog box, select ecengine and click the Startup button. The 
Service dialog box opens.
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Configuring as a Windows Service
4. In the Logon As box, select the This Account option. Type Administrator, or 
select it from the list (click the More button to see the list). Type the 
Administrator’s password in the fields.

Note: Make sure the Interact with the desktop option is not selected.

5. Click OK.

You can now start the Server application. If at some time Windows NT stops and 
is restarted, Server is also restarted and runs in the background. You also can 
reboot the Windows NT server to have the Server application run in the 
background.

Note: The WebLogic Integration – Business Connect Windows NT service is set 
to Automatic mode as the default. If you want to start and stop the 
application manually, you should change the mode to Manual in the 
Windows NT Services panel. For more information see “Changing the NT 
Service Start-Up Options” on page 3-7.

Configuring as a Windows 2000 Service

Use this procedure to configure WebLogic Integration – Business Connect as a service 
in Windows 2000.

1. Install the ECEngine utility. See “Installing the ECEngine Utility to Support 
Configuration as a Windows Service” on page 3-4.

2. Right-click on the My Computer icon on the desktop and select the Manage 
option. On the Computer Management window, expand the Services and 
Applications path and select Services.

3. Double-click the ECEngine service to open the ECEngine Properties window.

4. Select the Log On tab. Select the radio button for This account. In the field 
following This account, type Administrator or click Browse and select 
Administrator. Type the password for the Administrator user in the password and 
confirm password fields.

5. Make sure that Automatic displays in the Startup type field.

6. Click OK to save your changes and close the window.
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3 Installation on Windows
7. Close the Computer Management window.

The next time you start Windows, the WebLogic Integration – Business Connect 
Server application will start. You can use the Startup type field on the ECEngine 
Properties window to disable the service or change startup of the Server 
application from automatic to manual.

Starting as a Service

After you have installed WebLogic Integration – Business Connect as a service on 
Windows NT or Windows 2000, the Server application starts every time you reboot 
the computer or after every system outage.

Because WebLogic Integration – Business Connect runs in the background, the Server 
Display window does not display as when you start the Server application from the 
Start menu. To view transactions and other events as the system writes them to the 
console log, open the View Server Log tool.

Note: You can stop the Server application in the current Windows session by 
selecting Programs→BEA WebLogic Integration – Business Connect 
2.1→Stop Server on the Start menu. The next time you start Windows, the 
Server application starts again as a service.

Removing from the List of Services

Use this procedure to remove WebLogic Integration – Business Connect from the list 
of services in Windows NT or Windows 2000.

Steps

1. Click the Windows Start menu button and then open an MS-DOS command prompt 
window.

2. Use the cd command to change the current directory to the following:
installation_directory\util\NTService
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3. Then type the following: 
ECEngine.exe -u

4. Press Enter. The message “NT Service Uninstalled” appears.

5. Close the MS-DOS command prompt window.

Changing the NT Service Start-Up Options

The WebLogic Integration – Business Connect installation process installs the 
application as a service with an automatic start-up option. This means that the service 
is automatically started during Windows NT initialization. You can change this option 
if necessary.

Steps
1. In Windows click Start→Control Panel to open the Control Panel.

2. Double-click the Services icon. The Services dialog box appears.

3. Select WebLogic Integration – Business Connect in the Services box and then 
click the Setup button. The Service dialog box appears.

4. Select one of the following depending on your needs:
Automatic
Select this option to have WebLogic Integration – Business Connect start 
when Windows NT starts.
Manual
Select this option if you want to start WebLogic Integration – Business 
Connect manually from your desktop.
Disabled
Select this option if you do not want to run WebLogic Integration – Business 
Connect manually or automatically. This option leaves the WebLogic 
Integration – Business Connect in the list of available NT services in a 
disabled state.

Note: Make sure the Interact with the desktop option is not selected. This option 
is located at Start→Settings→Control Panel →Services→Startup.

5. Click OK on the Service dialog box and then click Close on the Services dialog 
box.
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Uninstalling on Windows

Use this procedure to remove WebLogic Integration – Business Connect from your 
Windows computer using the installation CD.

Note: To uninstall WebLogic Integration – Business Connect manually, delete the 
WebLogic Integration – Business Connect installation directory and the Start 
Programs menu shortcuts.

Steps

1. Place the installation CD in the CD-ROM drive.

2. Click Start→Settings→Control Panel to open the Control Panel window.

3. Click the Add/Remove Programs icon to open the Add/Remove Programs 
Properties dialog box.

4. Select the WebLogic Integration – Business Connect program you want to 
remove and then click the Remove button.

The uninstall program removes some of the application files and directories and 
deletes the folder containing the application shortcuts and the Start Programs 
menu shortcuts. You can remove the remaining components by deleting the 
WebLogic Integration – Business Connect installation directory.
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CHAPTER
4 Installation on UNIX

The following topics are provided for installing WebLogic Integration – Business 
Connect on computers with UNIX operating systems.

Concepts

“Initialization and Termination UNIX Script” on page 4-1

Procedures

“Installing on UNIX” on page 4-2

“Uninstalling on UNIX” on page 4-8

Initialization and Termination UNIX Script

After you have installed the application on UNIX, tested it to your satisfaction and are 
ready to place it into production, you might want to run it automatically in the 
background.

Installed with the application is a System V initialization and termination script that 
enables you to start WebLogic Integration – Business Connect when you boot your 
system and close it when you shut your system down. We recommend that you get 
assistance from your UNIX system administrator if you want to implement this script.

The script is named interchange and is installed in the following location for each 
UNIX operating system:

installation_directory/bin/interchange
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Installing on UNIX

Use this procedure as the starting point for installing WebLogic Integration – Business 
Connect on the supported UNIX operating systems. 

The default installation process is text-based, but you can use an option that activates 
a graphical user interface during installation.

The following steps are common to all UNIX operating systems. Once you perform 
them, you are directed to the procedure for your particular operating system to 
complete the installation.

When installing using the server installation CD you are asked to provide the location 
of your license.xml file. If you have purchased a license from BEA, provide the 
complete path to the license.xml file when prompted. If you are evaluating the 
software, leave the path blank. A a 30-day evaluation license will be created for you.  
See “About the User License File” on page 2-2.

Before you install WebLogic Integration – Business Connect, see Chapter 1, “System 
Requirements,” to ensure your hardware, software and communications are ready for 
installation of the application. In addition, see Chapter 2, “Installation and 
Configuration,” before installing.

Steps

1. Create a user account for WebLogic Integration – Business Connect (connect, for 
example) as the home directory for the application. For example, you can use one 
of the following as a home directory:
/opt/connect

/usr/local/connect

Note: The directory must not be automounted or on an automounted file system. 
WebLogic Integration – Business Connect cannot run correctly on an 
automounted file system. This applies to volumes mounted using the 
automount utility and not to volumes that are automatically mounted at 
startup. WebLogic Integration – Business Connect cannot be installed on 
automounted volumes because of automatic unmounting of such drives.
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2. Determine the device name of your CD-ROM drive.

The installation CD has a standard ISO-9660 (High Sierra) file system with 
Rock Ridge extensions.

3. Determine how much RAM your server has. You need to enter this information 
during the installation routine.

4. See the installation procedure for your operating system:

“Installing on Hewlett-Packard HP-UX” on page 4-4

“Installing on IBM AIX” on page 4-5

“Installing on Sun Solaris” on page 4-6

The following installation guidelines apply to all UNIX operating systems.

You can use the following options with the install.sh command:

When using the default text-based installation, be aware of the following:

Press Ctrl+C to cancel the installation at any time.

When the license agreement text displays, press Enter to scroll through the 
text until you reach the accept agreement prompt or type q and press Enter to 
skip through the license and go directly to the accept agreement prompt.

When the ready to install prompt appears, press Enter to install or type 2 and 
press Enter to cancel the installation.

Table 4-1  install.sh Options

Option Description

-g Uses a graphical user interface (GUI) for the installation routine. The default 
routine is text-based.
If you use this option, ensure you have X Windows connectivity to the server 
where you are going to install the application. This option tests for X Windows 
capability and, if the system passes, launches the GUI installation.

-s Logs screen output to the file 
installation_directory/logs/install.log

-x Prints all commands before they are executed. Used for debugging, this is a 
powerful tool when combined with the -s option.
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When prompted to select an installation directory, be advised that you cannot use 
a directory name that includes blank spaces.

When prompted to type the path where your HTML browser is located, you can 
skip this and specify a location later by selecting Tools→Preferences in 
Administrator. You use a browser to access the online help and obtain 
certificates from third-party certificate authorities. You will not be able to access 
the online help until you specify a browser.

Following installation, the Terminal window provides the command for starting 
Administrator. It also provides instructions for enabling group access to the 
application.

Installing on Hewlett-Packard HP-UX

Use this procedure to install the application on your Hewlett-Packard HP-UX server.

Steps

1. Log in as root.

2. Insert the WebLogic Integration – Business Connect CD into the CD-ROM drive.

3. If /mnt does not exist, create it with the following command:
mkdir /mnt

4. Mount the WebLogic Integration – Business Connect CD with the following 
command: 
mount -o cdcase /dev/dsk/* /mnt

where /dev/dsk/* is the device name of your CD-ROM.

5. Log out as root.

6. Log in to the account you created previously.

7. From the home directory, run the following command:
/mnt/hpux/install.sh
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8. Follow the instructions in the installation process.

9. Log out from the account.

10. Log in as root.

11. Unmount the WebLogic Integration – Business Connect CD by running the 
following command:
umount /mnt

12. Eject the WebLogic Integration – Business Connect CD from the CD-ROM 
drive.

13. Log out as root.

Installing on IBM AIX

Use this procedure to install the application on your IBM AIX server.

The Logical Volume Manager (LVM) enables the user to specify the physical sectors 
of the hard drive, or group of hard drives, to use when creating a volume on the AIX. 
The sectors closest to the center spindle of the disk generally give the fastest, most 
efficient, input and output reads and writes. The sectors towards the edge of the disk 
generally give the slowest input and output results. Once the LVM is used to create and 
mount a volume on the AIX, WebLogic Integration – Business Connect can be 
installed into a directory on that mount point just as it can with a non-LVM volume. 
The WebLogic Integration – Business Connect software itself is not aware of whether 
or not this is an LVM mount point.

Steps

1. Insert the WebLogic Integration – Business Connect CD into the CD-ROM drive.

2. Log in as root
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3. Run the command: 
mount -vcdrfs -r -p /dev/cd? /mnt

where /dev/cd? is the device name of your CD-ROM. Possible values are 0 
through 9. If you have only one CD-ROM, its number is probably 0.

4. Log out as root.

5. Log in to the account you created previously.

6. From the home directory, run the following command:
/mnt/aix/install.sh

7. Follow the instructions in the installation process.

8. Log out from the account.

9. Log in as root.

10. Unmount the CD by running the following command:
umount /mnt

11. Eject the CD from the CD-ROM drive.

12. Log out as root.

Installing on Sun Solaris

Use this procedure to install the application on your Sun Solaris server. Note that 
separate procedures are provided, depending on whether you are running the 
automounter.
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Steps

If you are running the automounter (the Solaris default):

1. Log in to the account you created previously.

2. Insert the WebLogic Integration – Business Connect CD into the CD-ROM drive.

3. From the home directory, run the following command:
/cdrom/solaris/install.sh

4. Follow the instructions in the installation process.

5. Eject the WebLogic Integration – Business Connect CD by running the following 
command:
eject cdrom

If you are not running the automounter:

1. Insert the WebLogic Integration – Business Connect CD into the CD-ROM drive.

2. Log in as root.

3. Run the command: 
mount /dev/sr? /mnt

where /dev/sr? is the device name of your CD-ROM. Possible values are 0 
through 9. If you have only one CD-ROM, its number is probably 0.

4. Log out as root.

5. Log in to the account you created previously.

6. From the home directory, run the following command:
/mnt/solaris/install.sh

7. Follow the instructions in the installation process.

8. Log out from the account.

9. Log in as root.
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10. Unmount the WebLogic Integration – Business Connect CD by running the 
following command:
umount /mnt

11. Eject the WebLogic Integration – Business Connect CD from the CD-ROM 
drive.

12. Log out as root.

Uninstalling on UNIX

Use this procedure to remove WebLogic Integration – Business Connect from your 
UNIX computer.

Steps

1. Log in to the account you created previously.

2. Shut down all WebLogic Integration – Business Connect applications.

3. Run the following command:
rm -rf installation_directory

All program files and documents are removed from your computer.
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CHAPTER
5 Upgrading

You can upgrade the application’s database from version 2.1 to version 7.0 of 
WebLogic Integration – Business Connect. Upgrading is a two-step process in which 
you install version 7.0 and then copy the database information from the previous 
version. The migration path ensures that you can use the company and partner profiles, 
certificates, schedules and logs from the previous version.

The database upgrade process is aimed at preserving the directory structure between 
versions. Although the directory structure remains the same, files within the directories 
do not migrate to the new, identical structure.

The following topics are provided:

Concepts

“Upgrade Requirements and Conditions” on page 5-2

Procedure

“Upgrade the Database” on page 5-2
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Upgrade Requirements and Conditions

Review the following requirements and conditions before you upgrade the database to 
version 7.0.

Do not uninstall your current version of WebLogic Integration – Business 
Connect. It must be present with its database files intact for the upgrade process 
to work.

After installing 7.0, you can run the 7.0 database upgrade utility only once. If 
you need to run it again, you must reinstall 7.0.

The 7.0 upgrade utility does not change the database used by the previous 
version.

You can upgrade on any platform WebLogic Integration – Business Connect 
supports, but only on the same platform and not across platforms. If you want to 
upgrade and change platforms (for example, Windows to UNIX) at the same 
time, you must install 7.0 on the new platform and then re-create your 
configuration data.

If you trade with any partners using bundled HTTP or HTTPS, you must update 
your company profile and send the updated profile to your partners after 
completing the 7.0 upgrade.

Upgrade the Database

Use this procedure to upgrade the database from version 2.1 to version 7.0 of 
WebLogic Integration – Business Connect. Upgrading is a two-step process in which 
you install version 7.0 and then copy the database information from the previous 
version to 7.0. Before upgrading, we recommend that you review “Upgrade 
Requirements and Conditions” on page 5-2.

Upgrading during a lull in trading is the preferred method.

If the upgrade process fails or if error messages you cannot resolve appear during the 
upgrade process, contact customer support for help.
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Steps

1. Resolve all document trading for your WebLogic Integration – Business Connect 
2.1 system. Make sure message disposition notices (MDNs) have been received for 
outbound documents. Make sure MDNs have been sent for inbound documents.

2. Stop the WebLogic Integration – Business Connect 2.1 Server application. This 
has the following effects:

Outbound messages accumulate in the outbound directories.

Inbound documents remain on the POP or FTP servers. HTTP or HTTPS 
documents are not received because the partner cannot connect to the internal 
HTTP or HTTPS server. (After conversion, these will be received normally.)

3. Export the configuration data from your WebLogic Integration – Business 
Connect 2.1 Administrator.

Select File→Export Administrator Data to open the Export Administrator Data 
window. Use the default name of the file to export, Administrator.dat, or 
type another file name. Select the directory where you want to save the file and 
click Save. You have the option to type a password to secure the exported file.

4. Export the log data from your WebLogic Integration – Business Connect 2.1 
Tracker.

Select File→Export Tracker Runtime Data to open the Export Tracker Runtime 
Data window. Use the default name of the file to export, Tracker.dat, or type 
another file name. Select the directory where you want to save the file and click 
Save. You have the option to type a password to secure the exported file.

5. Close your WebLogic Integration – Business Connect 2.1 Administrator and 
Tracker.

6. Rename the WebLogic Integration – Business Connect 2.1 directory. For 
example, on Windows you could rename the directory 
installation_directory_old.

7. Install version 7.0. See the installation topic for your platform.

If you want the directory structure for 7.0 to be identical to the previous 
version’s, make sure you install 7.0 in a directory of the same name as the 
previous version’s before you renamed the directory in previous step.

Ensure that the installation process runs without error.
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Note: After the application is installed, do not run any version 7.0 component 
(Administrator, Server or Tracker) until you have upgraded the database.

8. Start the 7.0 database upgrade utility and open the Upgrade Database window.

In Windows, the upgrade utility is in the WebLogic Integration – Business 
Connect bin directory. Double-click Upgrade.bat.

In UNIX, run the following command:
installation_directory/bin/upgrade

Figure 5-1   Upgrade Database window

9. Make sure the Configuration and Logs check boxes are selected. Both check 
boxes are selected by default.
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10. Click Browse next to the Configuration File field to open a browse dialog box. 
Select the directory where you saved the 2.1 Administrator.dat file in step 3 
and click Open.

If you set a password for the file, type the password in the Configuration 
Password field.

11. Click Browse next to the Logs File field to open a browse dialog box. Select the 
directory where you saved the 2.1 Tracker.dat file in step 4 and click Open.

If you set a password for the file, type the password in the Logs Password field.

Importing the Tracker.dat file is optional. 

12. Click Upgrade to start the upgrade process. When the process is completed, a 
message appears confirming the success of the upgrade.

13. Click OK to close the upgrade successful dialog box.

14. Click Close to close the Upgrade Database window.

15. You can now do the following to verify a complete and error-free conversion.

Start Administrator for 7.0 (see “Starting Administrator or Tracker” in  “Getting 
Started” in Using WebLogic Integration – Business Connect).

The conversion process preserves all user passwords. If you used a password to 
log on to Administrator and Tracker in the previous version, you need to use the 
same one to log on in version 7.0.

Verify the following:

Company profiles

Partner profiles, especially transport and security information

Certificates

Any schedules you set up

Users

Start Tracker and verify the presence of all system logs.

Note: Document files in the former version’s backup, rejected and archive 
directories are not copied to the new directories. Neither are archived 
system logs in the archive directory copied to the new directory.
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16. Do the following to resume trading. Start the version 7.0 Server. This results in 
new outbound documents being placed in the new EDI-, binary- or XML-out 
directories. Also, WebLogic Integration – Business Connect polls the POP3 
servers and processes any documents queued there.

WebLogic Integration – Business Connect can then re-establish bundled HTTP 
or HTTPS communications with partners who use those transports and receive 
any re-sent documents.

17. Using Tracker, monitor the exchange of documents to identify and resolve any 
exceptions.
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